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Abstract
This paper describes mathematical modelling of traditional graphic structures within tex-
tile materials using binary matrices, which is made possible by the binary nature of these 
structures. An algorithm is presented for woven design construction (weave draft, threading 
draft, treadling draft and tie-up), as well as an algorithm for weave reinforcement using bi-
nary matrices. The general advantage of the algorithm is its simplicity and execution speed. 
Application of the weave reinforcement algorithm is also presented in this paper, and the 
computer program, written in C#, shows the ease of its implementation, opening the way to 
integration into existing and new CAD/CAM packages.
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n	 Introduction
Woven structures are created by co-or-
dinated combining and interlacement of 
two sets of threads: one vertical or warp, 
and the other one horizontal or weft. 
Traditionally, the representation, plan-
ning and development of these structures 
require a graphic representation of the 
repeating weave draft, as well as repre-
sentation of the threading, treadling and 
tie-up. Although the representation of 
woven structures is quite simple, it still 
takes time and certain experience of tex-
tile technology for its development. The 
representation of woven structures and 
their development, supported by the de-
velopment of information technologies, 
is mathematically adapted for compu-
ter operations. CAD/CAM systems for 
textiles, just like electronically driven 
looms, work in a binary system (0, 1), 
using the well known fact that thread in-
terlaces can be defined in two ways only. 
Thinking along these lines, the designer 

of new woven structures and weave drafts 
need not be a textile engineer; he/she just 
has to know how to use a computer and 
should have a few bright ideas, i.e., some 
CAD systems have the generation of 
weave draft separated from other options, 
and most of them use a manual entry for 
the basic woven structure – weave draft. 
In the entry process, the combining and 
development of new and complex weave 
draft problems can arise, while faults are 
inevitable in the case of manual entry [1].

A possible solution for such problems 
is the structural development of weave 
drafts (woven fabric decomposition) 
based on the use of binary matrices and 
operations on them. The analogy of ma-
trix and graphical operations in compu-
ter theory and practice has been used for 
many years, thus it is a logical step to 
apply similar principles to woven struc-
tures.

Investigations in this field performed in 
the past were mostly concerned with find-
ing and suggesting an appropriate math-
ematical model or software algorithm for 
the representation of woven structures. 
The first papers were published about 50 
years ago, and more recent papers that 
describe the use of information technolo-
gies in textile technology are 20 years old 
only a few of them have been published 
recently [2] but some investigations in 
this field mainly concerned the binary 
coding of basic woven structures and 
their representation, trying to construct 
an appropriate algorithm for the woven 
design computation [3, 4]. Others were 
headed in various directions, from the 
design of mathematical models for some 
weave drafts all the way to algorithms 
for multilayered woven fabric develop-
ment [5 - 8]. Researchers in the field have 
mostly been oriented towards the appli-

cation of algorithms related to colour or-
der and their representation, thus solving 
designer’s problems only [9-13]. What is 
more, some models based on weave sym-
metry have been researched and devel-
oped [14, 15].

Investigations presented in this paper are 
based on the most common mathemati-
cal representation of weave draft – binary 
matrices. The goal of the investigations 
is the development of new algorithms for 
advancing specific procedures which still 
require manual editing in woven fabric 
construction, along with the implementa-
tion of the algorithms in order to verify 
the correctness and possibility of integra-
tion into CAD/CAM systems. It could be 
said that this paper is an extension of in-
vestigations presented in existing papers 
(considering fundamentals), but it also 
presents a solution for weave reinforce-
ment, contour thickening in motifs and 
a shading effect for the design and con-
struction of new woven fabrics.

	 Mathematical representation 
of woven structure

Mathematical representation of a woven 
fabric is based on the fact that a woven 
structure is composed of vertical (warp) 
and horizontal (weft) sets of threads that 
are perpendicular. These sets, on an im-
aginary intersection of each thread from 
the first set with each thread from the 
second set, form warp intersection points 
if the thread from the first set (warp) is 

Table 1. The results of Boolean operators.

A B A ∧ B A ∨ B

0 0 0 0
0 1 0 1
1 0 0 1
1 1 1 1
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positioned above the thread from the 
second set (weft), or they form weft in-
tersection points if the thread from the 
second set (weft) is positioned above the 
thread from the first set (warp).

In textile tradition, intersections are rep-
resented by fields of black and white 
squares. Due to their binary nature, the 
information on woven fabric design 
can easily be transferred to a compu-
ter through Boolean algebra, in which 
black squares denote “TRUE” (or 
number  1) and white squares “FALSE” 
(or number 0). Furthermore, we shall use 
two basic logic operators: logical and 
logical OR [16, 17]. Results for these op-
erators are given in Table 1. The operator 
AND is represented by the symbol ∧ and 
the operator OR by ∨.

Mathematical representation 
of a woven design
Black squares (warp thread over weft 
thread) are represented by 1, and white 
squares (weft thread over warp thread) 
by 0. The structure of black and white 
squares is equivalent to the table struc-
ture, hence the matrix definition can be 
applied to it [18, 19]. The structure men-
tioned can also be represented by two 
sets of ordered pairs: the set of weft inter-
section points, where the matrix element 
(i,j) equals zero, and the set of warp inter-
section points, where the matrix element 
(i,j) equals one.

In order to introduce a mathematical 
model for the computation of matrices in 
a woven design, we shall define m as the 
number of rows and n as the number of 
columns in the binary matrix M, which 
will represent the graphic structure m × n.

The matrix elements are:





=
squareblack  is  square if ,1
square  whiteis  square if ,0

(i,j)
(i,j)

mi,j (1)

The graphic structure shown in Figure 1 
is composed of 3 rows and 4 columns, 
which means that the corresponding 
matrix M must contain 3 rows and 4 
columns, and for the example given the 
matrix is:
















=

1000
0101
0010

M           (2)

Now we shall introduce the transpose 
TM  of matrix M. The transpose TM  has 

n rows and m columns, with the values 
defined in the following equation:

[ ] [ ]njmimm i,j
T
j,i ,1,,1     ∈∀∈∀=    (3)

In order to perform the operations on bi-
nary matrices from the woven design, we 
shall define the matrix operator * (which 
would be matrix multiplication for matri-
ces composed of real or complex num-
bers), considering the following:
n	 Binary matrix A has m rows and n col-

umns; its element is ai,k.

n	Binary matrix B has n rows and p col-
umns and its element is bk,j.

n	 Binary matrix C = A * B consequently 
contains m rows and p columns (like 
in the case of matrix multiplication). 
The elements of C are defined in the 
following way:

ci,j = (ai,1∧b1,j) ∨ (ai,2∧b2,j) ∨ ... 

... ∨ (ai,k∧bk,j) ∨ ... ∨ (ai,n∧bn,j)  (4)

[ ] [ ]pjmi ,1,,1 ∈∀∈∀

The woven design consists of four parts, 
each of which can be represented as a bi-
nary matrix. In the lower left segment of 
the woven design there is a weave draft 
representing matrix W, and to the right 
of it there is a treadling draft representing 
matrix V. The threading draft represent-
ing matrix H is shown in the upper left 
segment, and finally in the upper right 
segment there is a tie-up draft defined by 
binary matrix E.

The requirement that each thread in the 
weave be stitched in at least one intersec-
tion point means that matrix W has to 
have at least one “1” and one “0” in each 
row and each column. Otherwise, such 
thread would remain free unintegrated 
in the woven fabric construction. This 
requirement is fulfilled in our example, 
which will later be used for demonstra-
tion of the weave reinforcement algo-
rithm.

Equation (5) is a matrix representation of 
the weave draft from Figure 3.

































=

10000010001000
01000100010100
00101000100010
00010001000001
10000010001000
01000100010100
00101000100010
01000100010100

W

	

(5)

Only one warp thread can pass through 
one shaft in the loom, which means that 
binary matrix H in each column must 
have exactly one “1”. Of course, there 
can be more “1”s in a row of matrix H, 
the number depending on the number of 
equal columns of W. The threading draft 
of the weave draft shown in Figure 3, is 
shown in Figure 4.

Binary matrix H, which represents the 
threading draft from Figure 4, is shown 
in Equation (6):



















=

10000010001000
01000100010100
00101000100010
00010001000001

H

	
(6)

A simple algorithm for the construction 
of matrix H is given.

The number of rows in H equals a dis-
tinctive column count from W, and all 
the values in matrix H at the beginning 
will be “0”. For the first column of W, we 
shall put “1” in position (1,1) of matrix 

Figure 4. Threading draft.

Figure 3. Weave draft.

Figure 1. Graphic representation of a wo-
ven structure.

Figure 2. Woven design.if
if

is
is
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H. For each next i-th column in matrix 
W, we will compare it to each prior j-th 
column; if the i-th column is equal to the 
j-th column, then matrix H in position 
(j,i) will contain the value “1”, and if the 
i-th column is not equal to any prior col-
umn, we put “1” in the i-th column in the 
first free row of binary matrix H. The ex-
pression “first free row in H” means the 
first row in H contains only “0” values. It 
is important to mention that comparison 
of column equality in matrix W always 
starts from the first column.

The harness lifting draft, which is a part 
of a woven design, is represented by bi-

nary matrix V. Harnesses that are lifted 
participate in the creation of woven fab-
ric. Number 1 in i-th row and j-th column 
of matrix V represents the lifting of the 
j-th harness in i-th row of a weave draft. 
Thus it is possible with known W and H 
to determine V. This appears simple if 
matrix E is an exchange matrix.

Generally, matrix V is computed by per-
forming operation * on matrices W, H 
and E according to Equation (7) [20].

EHWV T **=                  (7)

Equation (8) is used for calculation of the 
weave draft (W) from the threading, trea-
dling and tie-up draft.

HEVW **=                   (8)

Binary matrix V, obtained by entering 
matrices W, E and H from our example 
into Equation (7), is computed in Equa-
tion (9).

The graphic representation of matrix V is 
a treadling draft, given in our example in 
Figure 5.

Binary matrix E is actually an exchange 
matrix, which is a special case amongst 
permutation matrices; in other words, it 
is a row-reversed version of an identity 
matrix.

Importance of weave reinforcement 
in woven fabric construction

Reinforced weave is formed by adding 
warp intersection points to the weave 
draft with a weft effect, the weave draft 
size remaining the same. Adding warp 
intersection points can be done on any 
side (left, right, up, down) of the exist-
ing warp intersection point, but it has to 
be uniform throughout the weave draft. 
The reinforcement process may continue 
while there are at least two weft intersec-
tion points for each weft thread. If there 
is only one weft intersection point for the 
weft thread, the result is a warp effect 
weave. The process of weave reinforce-
ment is mostly used in weave shadowing, 
in other words in a gradient transition 
from the weft effect to the warp effect 
and vice versa. Weave reinforcement is 
used not only in weave design but also 
for making lines thicker for one or more 
pixels in the process of drawing motifs. 
An example is shown in Figure 6, where 
the original picture is on the left, and the 
reinforcement of contours made with Re-
inforcedWeave software is on the right. 

This procedure not only preserves line 
continuity and connectivity but also 
closed areas. Closed areas in a motif are 
usually filled with colour in the process 
of weave design, and by ensuring that 
closed areas are preserved after the rein-
forcement, the problem of flooding other 
areas is solved. The reinforcement proce-
dure also enables continuous and correct 
work with multicoloured shading, i.e. 
step transition from the weft to warp ef-
fect and vice versa. The fineness of con-
tinuous transitions from a light to dark 
effect and vice versa has a significant im-
pact on the aesthetic value of woven fab-
rics. Such effects are rarely used in textile 
engineering since the manual editing of a 
weave draft is inevitable. The weave re-
inforcement algorithm presented solves 
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0010
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*

0001
0010
0100
1000
0100
0010
0001
1000
0100
0010
0001
0010
0100
1000

*

10000010001000
01010100010100
00101000100010
00000001000001
10000010001000
01000100010100
00101000100010
01000100010100

V

Figure 6. a) original picture; b) picture after 
the reinforcement.

a) b)

Figure 5. Treadling draft.

(9)
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
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10001000
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00100010
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*
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*
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T

eV

Figure 7. Reinforced treadling draft. 

Figure 8. Reinforced weave draft.

Equations 9, 13.

(13)
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was implemented in the demonstration 
software ReinforcedWeave. This pro-
gram was modularly implemented in the 
C# language (under .NET framework), 
hence it offers easy further development, 
upgrades and implementation of other 
weave draft alteration actions, with a 
minimal time loss for the adaptation of 
existing modules [21, 22]. Current imple-
mentation is limited only by the weave 
draft size to be used; however, it can be 
easily extended to the full formats used 
in the textile industry. Also, the input 

By entering matrices E and S into Equa-
tion (11), binary matrix Ve is obtained, as 
shown in Equation (13).

The graphic representation of the com-
puted matrix Ve can be found in Figure 7.

By using Equation (8) and replacing the 
matrix names (matrix V is replaced by 
the new matrix Ve), we get Equation (14).

We = Ve * E * H          (14)

The result of weave reinforcement is a 
final weave draft, represented by matrix 
We, Equation (15) being an example.

A graphic representation of the rein-
forced weave draft is shown in Figure 8.

The algorithm for weave reinforcement 
described can be expressed in a simpler 
way, as seen in Equation (16):

HESHWW TT ****=e      (16)

Equation (16), which describes the weave 
reinforcement algorithm, transformed 
into pseudo code is shown in Figure 9. 
Note that simple operations like matrix 
transposition are not presented here in a 
form of pseudo code.

Weave reinforcement can be performed 
with a moderate number of reinforced in-
tersection points (M), while there are at 
least two weft intersection points in each 
weft thread. If this is the case, we need 
to redefine the values for the elements of 
matrix S, as in Equation (17):

si,j =

 { 1, if (ek,j = 1,k = (i + 	
		  + m - 1)modN + 1,∀i,j∈[1,N])
		  ∀m∈[0,M - 1]                     (17)
	           0, otherwise

	 Software implementation 
of the matrix model

Weave draft representation in the form 
of a binary matrix is appropriate for stor-
age and efficient computations, which 

the problem of human intervention in 
weave draft design mentioned.

	 Weave reinforcement 
algorithm with example

A mathematical algorithm for weave re-
inforcement is presented in this paper. In 
order to describe the algorithm, we shall 
firstly name the binary matrices used 
later.

W	 is a matrix representing the initial 
weave draft

H	 is a matrix representing the threading 
draft

V	 is a matrix representing the initial 
treadling draft

We	is a matrix representing the final 
(ending) weave draft

Ve	 is a matrix representing the treadling 
draft of the final weave

E	 is an exchange binary matrix N × N 
(where N is the row count of H), rep-
resenting the tie-up draft

S	 is a reinforced N × N binary matrix 
where N is the row count of H 

The matrix S is constructed from ex-
change matrix E, according to Equation 
(10).

si,j =

 { 1, if (ei,j = 1 (∀i,j∈[1,N]))∨
	            ∨(ei,j = 1, k = imodN + 1,        10)	          ∀i,j∈[1,N])
	           0, otherwise

In order to perform the reinforcement, we 
shall continue with the computation of 
Ve, according to the following equation:

( )TT
e VESV **=           (11)

In our example, matrices E and S, ac-
cording to the Equation (12), are:


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


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=
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,
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SE    (12)
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10010011001001
11000110011100
01101100110110
00111001100011
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11000110011100
01101100110110
11000110011100

10000010001000
01000100010100
00101000100010
00010001000001

*
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1000

*

1001
0011
0110
1100
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0011
0110
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eW

Equation 15.

(15)

ReinforcementAlgorithm(W)
{
 /* input: W; output: We; */
 BinaryMatrix 
W,H,HT,S,ST,E,H,We,Temp;
 H = CalculateH(W);
 HT = Transpose(H);
 E = ExchangeMatrix;
 S = Reinforce(E);
 ST = Transpose(S);
 We = OpAsterisk(W, OpAsterisk(HT, 
OpAsterisk(ST, OpAsterisk(E, H))));
 return We;
}

Reinforce(E)
{
 /* input: E; output: S; */
 BinaryMatrix S;
 S = NullMatrix;
 N = rows(E);
 for i = 1 to N
 for j = 1 to N
 k = (i MOD N) + 1;
 if (E[i,j] == 1) OR (E[k,j] == 1)
 then S[i,j] = 1;
 else S[i,j] = 0;
 return S;
}

OpAsterisk(A,B)
{
 /* input: A,B; output: C; */
 BinaryMatrix C = NullMatrix;
 for i = 1 to rows(A)
 for j = 1 to columns(B)
 for k = 1 to columns(A)
 C[i,j] = C[i,j] OR 
(A[i,k] AND B[k,j]);

 return C

}

Figure 9. Listing 1 - pseudo code for the 
weave reinforcement algorithm.
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the pink squares represent warp intersec-
tion points in the reinforced weave draft, 
which were weft intersection points in 
the original weave draft, and the light 
grey squares represent weft intersection 
points in both the original and reinforced 
weave draft. The example shown in Fig-
ure 10 was reinforced using the software, 
and a screenshot of the reinforced weave 
is shown in Figure 11. We can save the 
reinforced weave draft to the windows 
bitmap file by choosing Export from the 
File menu.

We can perform changes to the intersec-
tion points in the weave draft with a left 
mouse click on a square in the weave 
draft, which toggles intersection points 
from the warp to the weft intersection 
point and vice versa. Changes to matrices 
E and S are performed in the same way.

The options Open, Save and Save As 
from the File menu can be used to load 
and store the complete woven design to 
the file. The example from this paper has 

been included in the examples the Rein-
forcedWeave originally came with.

Additional possibilities and the Pegplan 
mode are described in the program help, 
which can be obtained by choosing Con-
tents from the Help menu. In the status 
bar at the bottom of the window, we can 
see a message whether the weave draft 
currently shown in the screen is valid or 
not. The ReinforcedWeave software has 
a limit for the weave draft size – the max-
imal size is up to 300 × 300 intersection 
points. However, we consider it adequate 
for demonstration purposes.

n	 Conclusion
n	 in the mathematical model (one of 

many possible) presented in this pa-
per, binary matrices are used which 
have an equivalent structure to the tra-
ditional graphical woven structures, 
enabling easier application of the 
model,

and output formats for storing the weave 
draft and the whole woven design can be 
expanded with industrial standards. The 
initial window of the ReinforcedWeave 
program is presented in Figure 10, along 
with the sample weave draft.

Below is a list of matrix representations 
in the Tie-up mode:
n	 top left: threading draft representing 

matrix H
n	 top right: representation of matrix E 

or matrix S (with the Reinforcement 
enabled) 

n	 bottom left: representation of matrix 
W (weave draft) or matrix We (rein-
forced weave draft)

n	 bottom right: representation of matrix 
V (treadling draft) or matrix Ve (rein-
forced treadling draft)

Below is a list of the options in the pro-
gram: 
n	 The number of wefts: the number of 

weft threads – the number of rows in 
matrix W

n	 The number of warps: the number of 
warp threads – the number of columns 
in matrix W

n	 The number of reinforcements: the 
number of reinforced points (1 – no 
reinforcement)

n	 Show reinforced: enable/disable rein-
forcement

n	 Pegplan / Tie-up: working mode se-
lection (reinforcement demonstration 
can be performed using the Tie-up 
mode)

In order to create a reinforced weave draft 
with the ReinforcedWeave software, we 
have to start by choosing New from the 
File menu. After that, we need to enter 
the weave draft size in the boxes Weft 
threads and Warp threads, plus draw the 
weave draft in the corresponding area. A 
screenshot after making and drawing a 
new weave draft is shown in Figure 10. 
If we already have a weave draft in the 
windows bitmap file, we can select Im-
port from the File menu and choose that 
file instead of the procedure previously 
described.

The reinforcement process is enabled 
by checking the Show reinforced option 
and by choosing the reinforcement size 
in the box Number of reinforcements. 
The reinforced weave draft is presented 
in the place where the original weave 
draft was. The blue squares represent 
warp intersection points present both in 
the original and reinforced weave draft; 

Figure 10. A new woven design entered into the ReinforcedWeave software.

Figure 11. Weave draft in the software after reinforcement.
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n	 automated weave reinforcement with 
a moderate number of reinforcements 
shortens the development time and 
reduces expenses in the woven fabric 
construction process,

n	 through the development of the model 
and the CAD software prototype Re-
inforcedWeave, the simplicity of auto-
mated weave reinforcement is shown; 
the software can easily be used in in-
dustry with minor adjustments,

n	 the model presented enables simple 
and efficient application in the further 
development of CAD software pack-
ages for the analysis and construction 
of simple and complex multilayered 
woven fabrics,

n	 the reinforcement process described 
can be applied to computer graphics, 
where the weave draft containing warp 
and weft intersection points should be 
replaced by pictures containing black 
and white or colour pixels, 

n	 the ReinforcedWeave software can 
be downloaded at http://www.ttf.
hr/~zpenava/ReinforcedWeave.zip, 

n	 the weave reinforcement procedure in 
textile engineering simplifies weave 
design as well as the making of closed 
contours in motifs.
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